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Шинэ параграф эхлүүлэх 

Текстэн мэдээлэлтэй ажиллах хэрэглээний програм Word  текстийг автоматаар 

дараагийн мөр рүү шилжүүлдэг. Харин гараас Enter товчлуур дарж шилжүүлсэн 

тохиолдолд шинэ параграф буюу догол мөр эхэлнэ. 

Шинээр үүсгэсэн баримт хадгалах : Баримтыг үүсгэсний дараа хадгалахад File цэсийн 

Save командыг сонгоно. Файлын нэр, хадгалах замыг нь зааж өгөх шаардлагатай. (Зураг 1) 

1. File цэсийн Save командыг сонгоно. Эсвэл стандарт хэрэгслийн мөрөөс файл хадгалах 

товчлуур дарна. Ингэхэд хадгалах файлын нэр бичих цонх гарна. 

2. File name хэсэгт файлын нэрийг бичиж өгнө. 

3. Save товчлуур дарж файлаа хадгална. 

 

Зураг 1   Баримтыг дахин нэр өгч хадгалах цонх 

Тодорхой утга санаа илэрхийлсэн хэсэг текстийг параграф гэнэ. Параграфийг хэл 

шинжлэлийн шинжлэх ухаанд (¶) тэмдгээр тэмдэглэдэг. Товчлуурт гар дээрх Enter товчийг 

дарах бүрд шинэ параграф эхэлдэг. Текст шивэх явцад текст нь хуудасны баруун захад 

хүрсэн тохиолдолд Word автоматаар мөр шилжүүлдэг үүнийг мөр шилжүүлэлт (word wrap) 

гэдэг. Харин богино текст бичих, хоосон мөр үүсгэх, параграфыг дуусгах болон шинэ 

параграф эхлүүлэхэд Enter товчийг дарна. 

 



 

Хадгалсан баримтын нэрийг өөрчлөх : File цэсийн Save as командыг сонгоход 

хадгалах цонх гарна. Файлын нэр хэсэгт өмнө өгөгдсөн баримтын нэр бичигдсэн байна. File 

name хэсэгт байгаа нэрийг өөрчилж шинээр өгөх нэрээ бичнэ. Өөрчлөлтүүдээ хийсний 

дараа хадгалах (Save) товчлуурыг дарна. 

Хайлт хийх: Бичсэн мэдээллээ буцаж шалгах, нэмэлт өөрчлөлт хийх үед текстээс хайлт 

хийх шаардлага гарна. Үүнийг Edit цэсийн Хайлт хийх (Find) командаар хялбархан 

гүйцэтгэнэ. Хайлт хийхдээ:  

1. Edit ->Find -> Find and Replace цонх гарна (Зураг 2)  

2. Хайх мэдээлэл (Find What) хэсгийн ард хайх текстээ бичнэ. Нийт 255 хүртэл тэмдэгт 

байж болно. 

3. Дараагийн мэдээлэл хайх (Find Next) товчлууроор хайлтыг эхлүүлнэ. Хайсан текст 

олдвол дахин Find Next товчлууроо дарж хайлтыг үргэлжлүүлнэ. 

 

 

 

 

 

Зураг 2  Хайлт хийх цонх 

Хайлт хийхдээ нэмэлт сонголтуудыг зааж өгч болно. Үүний тулд нэмэлт сонголтуудыг 

гаргах (More) товчлуур дарна. Нэмэлт сонголт гаргах товчлуур дарахад товчлуурны нэр 

(Less) өөрчлөгдөнө. Нэмэлт сонголтыг харагдахгүй болгох (Less) товчлуур дарж 

сонголтуудыг харагдахгүй болгож болно. Сонголтуудын утгыг хүснэгт 1-оор үзүүлэв. 

Хүснэгт 1 Хайлтын нэмэлт сонголтууд 

Сонголт Утга 

Match Case Том жижиг үсгийг ялгаатайгаар хайна. 

Find Whole Words 

Only 

Үгийн хэсэгт ороогүй бүтэн үгээр байгааг хайна. 

Жишээ нь энэ сонголт хийгдсэн үед гол гэсэн үгийг 



хайж байгаа бол монгол гэсэн үгэнд орсон хэсгийг 

олохгүй. 

Use Pattern Matching Хайлтын оператор (? * ) хэрэглэнэ. 

Sounds Like Ойролцоо дуудлагатай үгсийг хайна. 

Find All Word Form 

Бичигдсэн хэлбэртэй бүх үгийг хайна. Гол гэсэн үг 

хайж байгаа бол монгол гэсэн үгээс гол гэсэн үгийг 

нь олно. 

Search  Хайлт хийх чиглэлийг зааж өгнө. 

All Бүх чиглэлд хайлт хийнэ. 

Up Мэдээллийн төгсгөлөөс эхлэл рүү хайлт хийнэ. 

Down Мэдээллийн эхлэлээс төгсгөл рүү хайлт хийнэ. 

Үгийн болон дүрмийн алдаа шалгах  

Мэдээллийн алдааг Word  толь бичгийн тусламжтайгаар шалгаж болно. Ямар хэл дээр 

бичигдсэн мэдээллийг шалгахаа Tools цэсээс Language команд сонгоно. Шалгалтыг зөвхөн 

харгалзах толь бичигтэй үед хийдэг. Таны шалгаж байгаа үг тольд байхгүй бол нэмэх 

боломжтой.Үгийн болон дүрмийн алдаа шалгах цонхыг зураг 3-т үзүүлэв.   

    

 

 

 

 

 

 

Зураг 3 Үгийн болон дүрмийн алдаа шалгах 

Үгийн алдааг шалгахдаа Ctrl ба Home товчлуурыг хамт дарж, курсорыг мэдээллийн эхэнд 

байрлуулах хэрэгтэй.  



1. Tools цэсээс Үгийн болон дүрмийн алдаа шалгах (Spelling and Grammer) командыг 

сонгоно.  

2. Эсвэл стандарт хэрэгслийн мөрөөс үг шалгах      товчлуур дарна. Шалгах 

цонхонд алдаатай үгийг улаан өнгөөр харуулна. Алдаатай үгийг засахад тусламж 

болгож ойролцоо бичлэгтэй үгсийг санал болгодог. Цонхонд гарч байгаа товчнуудаас 

сонгож хариу үйлдэл гүйцэтгэнэ. Дүрмийн алдаа шалгах гэж байгаа бол алдаа шалгахыг 

заасан (Check grammer) хэсэгт тэмдэглэгээ хийнэ. 

       Хүснэгт 2  Үгийн алдаа шалгах командуудын үүрэг 

Товчлуур Утга 

Ignore Алдааг тооцолгүй шалгалтыг цааш үргэлжлүүлнэ. 

Ignore All Гарсан бүх алдааг тооцохгүй. 

Add 

Алдаатай гэж гаргасан үгийг та зөв гэдгийг мэдэж 

байгаа бол толь бичигт нэмж болно. Ингэснээр энэ 

үгийг дахин алдаатай гэж гаргахгүй. 

Change  
Алдаж бичсэн үгийг солихдоо санал болгосон үгсээс зөв 

үгээ сонгоод Солих (Change) товчлуур дарна.  

Change All Алдаатай үгсийг сонгосон үгээр өөрчлөн солино. 

Autocorrect Засагдаж болох алдааг автоматаар засна. 

Undo  Хийсэн өөрчлөлтийг буцаана. 

Cancel Алдаа шалгах цонхноос гарна. 

Мөр хоорондын зай тохируулах  

Баримтын  мөр хоорондын зайг өөрчилж болно. Эхлээд курсороо баримтын хэсэгт 

байрлуулна. 

1. Format цэсээс Paragraph командыг сонгоно. 

2. Line spacing хэсгийн ард байгаа сумыг дарж жагсаалтаас сонголт хийнэ. 

3. Ок товчлуурыг дарж дараах сонголтоо баталгаажуулна.     Эдгээрт Single - нэг мөрийн 

зайтай, Line - 1.5 мөрийн зайтай, Double - 2 мөрийн зайтай, Exactly - өгөгдсөн хэмжээ, 

At least - хамгийн багадаа ямар хэмжээтэй байх зай, Multiple - хэд хэдэн мөрийн зайтай 

байхаар мөрийн тоог зааж өгнө.   



 Гарчгийн нэрс гаргах хэлбэр (Online view) : Мэдээллийг бичих явцад тод, налуу 

сонголт хийж бичсэн хэсгийг Word програм гарчиг гэж таньдаг. Бичиж байгаа текстийн 

гарчгийн хэсгүүдийгхарах, тухайн хэсгүүд рүү шилжихэд энэ хэлбэр тусална.     

 Хуудасны хязгаар харах хэлбэр (Page layout view) : Хуудсан дээр байгаа бүх 

мэдээллийг харахдаа хуудасны хязгаар харах сонголт хийнэ. Мөн хуудас хуудсаар нь 

шилжин харах бололцоотой. Хуудасны хязгаар харах (Layout View) хэлбэрт шилжихдээ 

View цэсийн Page Layout командыг сонгоно.  

 Баримт зохион байгуулах хэлбэр (Outline view) : Баримт харах Outline View хэлбэрт 

ажиллах явцад зөвхөн баримтыг харах бус түүнийг зохион байгуулах ажлыг хамт хийх 

бололцоотойгоороо онцлогтой. Энэ хэлбэрт баримтын бичигдэх хэлбэрийг өөрчлөх, 

баримтаас ялган харах зэрэг олон боломжийг ашиглаж болно.  (Зураг 4) Баримт зохион 

байгуулах хэлбэрт шилжихдээ: View цэсийн Outline командыг сонгоно.  

 

 

 

 

 

 

 

Зураг  4  Баримт зохион байгуулах хэлбэр 

Дэлгэц дүүргэн харах (Full screen view)  

 Баримтыг энэ хэлбэрээр харахад Word програмын баримтыг хэвжүүлж байгаа бүх цэс, 

хэрэгслийн мөр, чиглүүлэгч зэргийг харагдахгүй болгож, зөвхөн мэдээлэл бүхий дэлгэцийг 

гаргана. Баримтыг бүхэл дэлгэцээр харах хэлбэрт шилжихдээ View цэсээс Full Screen 

командыг сонгоно. Бүхэл дэлгэцээр харах хэлбэрээс гарахдаа гарах товчлуур (Close Full 

Screen) дарна. Баримтын дэлгэцэнд харагдах хэмжээг өөрчилж харах (Zoom control) 

команд байна. 

Font сонгох  



Баримтыг  үсгийн ямар фонтоор бичихээ Home цэсээс Font командыг ашиглана. (Зураг 5) 

 

    Зураг 5 Фонттой ажиллах командын цонх 

Баримтыг хэвжүүлэх  

Word програм бичсэн баримт, текстийг хялбархан хэвжүүлнэ. Текстээс тодорхой 

хэсгийг тэмдэглээд хэвжүүлэх үйлдлээ гүйцэтгэнэ. Мөн текст бичих явцад мөрөнд мэдээлэл 

багтахгүй болмогц курсор дараагийн мөр рүү автоматаар шилждэг. Харин Enter товчлуур 

дарж мөр шилжихэд шинэ параграф эхэлж байна гэж үзээд тэмдэг  тавьдаг. Гэхдээ энэ 

тэмдэглэгээ таны нүдэнд шууд харагдахгүй. Учир нь нууцлалт хийгдсэн байдаг. Энэ 

нууцлалтыг харуулахдаа стандарт хэрэгслийн мөрөөс товчлуурыг дарна. Баримтыг 

хэвжүүлэхдээ дараах тохируулгуудыг хийнэ. Нэгд, хуудасны хязгаар тавих: Page Layout 

цэсээс хуудсанд тохируулга хийх (Page Setup) командыг сонгоно. 

1. Хуудасны хязгаар (Margins) хэсгийг идэвхжүүлнэ. 

2. Хуудасны баруун, зүүн, дээд, доод зайн хэмжээг тохируулна. 

3. Сонголтуудаа (Хүснэгт 3) гүйцэтгээд Ok товчлуурыг дарна.  

Хүснэгт  3 Сонголтуудын төрлүүд 

Сонголт Утга 

Top Хуудасны дээд талын зайн хэмжээ 

Bottom Хуудасны доод талын зайн хэмжээ 

Left Хуудасны зүүн талын зайн хэмжээ 



Right Хуудасны баруун талын зайн хэмжээ 

Gutter Хуудасны үдээсний зайн хэмжээ 

Header Толгойн хэсэг бичигдэх зайн хэмжээ 

Footer Төгсгөлийн хэсэг бичигдэх зайн хэмжээ 

Баримтын хуудасны тохиргоо  

Цаасны хэмжээг сонгохдоо File цэсээс Хуудсанд тохируулга хийх (Page Setup) команд 

сонгоно. Цаасны хэмжээ (Paper Size) хэсгийг идэвхжүүлнэ. (Зураг 6) Цаасны хэмжээ сонгох 

хэсгийн ард байрлах сумыг дарж жагсаалт гаргаад төрлөө сонгоно. Эсвэл цаасны өндөр 

(Height), өргөнийг (Width) хэрэглэгч өөрөө тодорхойлж өгч болно. Цаасны чиглэл хэсэгт 

(Orientation) цаасыг яаж байрлуулахаа заана. Сонгосон цаасыг босоогоор (Portrait), 

хэвтээгээр (Landscape) байрлуулж болно. Ok товчлуур дарж сонголтоо баталгаажуулна. 

Cancel товчлуураар хэрэгсэхгүй болгоно. Default товчлуур дарвал таны сонгосон сонголт 

Word эхлэхэд тавигдсан байх болно.  

 

Зураг 6  Баримтын хуудасны тохиргоо 

Хуудсанд эхлэл ба төгсгөлийг тавих: Хуудасны эхлэлийн болон төгсгөлийн хэсэгт 

хуудас бүрийн эхлэл, төгсгөлд байх мэдээллийг бичнэ. Нэг баримт өөр өөр эхлэл 



төгсгөлийн хэсэгтэй байж болно. Жишээ нь: номын бүлэг бүр өөрийн бүлгийн дугаарыг 

бичсэн байж болно. 

Хуудасны эхлэл төгсгөлийн хэсгийг оруулах: Курсор хуудсан дээр байрлана. 

Дараах командуудыг хэрэглэнэ. View цэсээс эхлэл төгсгөлийн хэсэг (Header and Footer) 

командыг сонгоно. Ингэхэд хуудасны эхлэлийн ба төгсгөлийн хэсэгтэй ажиллах хэрэгслийн 

мөр гарна. Энэ мөр дээрх товчлуурны үүргийг доор үзүүлэв. Мэдээллээ бичнэ. Эхлэл 

төгсгөлийн хэсгээс гарах (Close) товчлуур дарна. Баримтыг хэд хэдэн хэсэгт (Section) 

хувааж болно. Хэсэг тус бүр өөр өөр эхлэл төгсгөлийн мэдээлэл агуулах боломжтой. 

Хэрэгслийн мөрийн товчлуурын үүргийг хүснэгт 3.5-аар ангилж үзүүлсэн.  

Хүснэгт  3.5   Хэрэгслийн мөрийн командуудын үүрэг 

Товчлуурны нэр Үүрэг 

Insert Auto Text Эхлэл төгсгөлийн хэсэгт бэлэн текст оруулна. 

Insert Page Number Хуудасны дугаар тавина. 

Insert Number of 

Pages 

Нийт хэдэн хуудас мэдээллийн хэд дэх хуудас 

болохыг заасан дугаар тавина.  

Format Page Number Хуудасны дугаарлалтад тохируулга хийнэ. 

Insert Date Огноо оруулна.  

Insert Time Цаг оруулна. 

Page Setup Хуудсанд тохируулга хийх цонх гаргана. 

Show/Hide Document Баримтыг дэлгэцэнд харуулах ба нууцлана. 

Same as Previous 
Өмнөх хэсэгтэй ижил мэдээллийг эхлэл 

төгсгөлийн хэсэгт бичнэ. 

Switch between 

Header Footer 
Эхлэл, төгсгөлийн хэсэг рүү ээлжлэн шилжинэ. 

Show Previous 
Баримт хэсгүүдэд хуваагдсан бол өмнөх хэсгийн 

мэдээллийг харуулна. 

Show Next Дараагийн хэсгийн мэдээллийг харуулна. 

Close Эхлэл төгсгөлийн хэсгээс гарна. 



Хуудсанд дугаар тавихдаа эхлэл төгсгөлийн хэсэг ашиглахаас гадна оруулга хийх (Insert) 

цэсээс Хуудасны дугаар (Page Numbers) команд сонгоно. Дугаарлалтыг дурын тооноос 

эхлэн тавьж болно. Хуудсанд дугаар тавих цонх (Зураг 7) 

 

Зураг 7  Хуудасны дугаарлалт 

1. Insert ->Header & Footer  ->Page Number командын хэрэгсэл дээр дарна.  

2. Нээгдэх цэснээс байрлалын командуудыг сонгоно: Эдгээрт Top of Page–хуудасны дээд 

хэсэгт, Button of Page–хуудасны доод хэсэгт, Page Margins–хуудасны зүүн баруун 

захын зайны дээд доод хэсэгт, Current Position–курсор байгаа байрлалуудаас сонгоно. 

3. Format Page Numbers –Хуудас дугаарын хэлбэрийг өөрчлөх мөн Remove Page 

Numbers –Хуудасны дугаарыг устгах үүрэгтэй. 

4. Эхлэх дугаарыг өөрчлөхдөө баримтанд курсорыг байрлуулна. 

5.  Insert->Header & Footer->Page Number командын хэрэгсэл дээр дарна.  

6. Нээгдэх цэснээс Format Page Numbers -> Start At талбарт дугаарлалтын тоог тавьж Ok 

дарна.  

Дугаар болон тэмдэглэгээг хэвжүүлэх 

Дугаар болон тэмдэглэгээний тавих хэлбэр, хэмжээг өөрчилж болно. Үүний тулд Format 

цэсээс дугаарлалт ба тэмдэглэгээ (Bullets and Numbering) командыг сонгоно. Тэмдэглэгээг 

өөрчлөх бол Bulleted сонголт хийнэ. Дугаар өөрчлөх бол Numbered сонголт хийж, 

дугаарлалт болон тэмдэглэгээ тавих хэлбэр сонгоно. Хэрэв сонгосон хэлбэр, хэмжээ 

өөрчлөх бол хэрэглэгчийн тохируулга хийх (Customise) товчлуур дарна. 

Тавигдсан тэмдэглэгээ дугаарыг авах 



Мэдээлэлд тавигдсан тэмдэглэгээ, дугаарлалтыг шаардлагагүй гэж үзвэл авч болно. 

Дугаарлалт болон тэмдэглэгээг авах мөрөндөө курсороо байрлуулна. Дугаарлалт авах гэж 

байгаа бол хэрэгслийн мөрөөс дугаарлалтын товчлуурыг дарна. Тэмдэглэгээ авах бол 

тэмдэглэгээний товчлуурыг дарна. 
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